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What You Can 
Do in Excel

Lay Out a Worksheet
When you sit down to develop a worksheet with
a pencil and ledger paper, you do not always
have all the information to complete the design
and layout of the worksheet. Ideas may occur to
you after you sketch the layout of your
worksheet. After you are finished jotting down
the column headings and the row headings, you
might think of another column or row that you
did not include. If you are working with pencil
and paper, restructuring the layout of a
worksheet can be tedious and time-consuming.
With Excel, you can easily insert columns and
rows and move information from one location to
another. 

Calculate Numbers
Think about the tasks involved in managing your
checkbook register. You subtract the amount of
each check written and add the deposits to the
running balance. You then use your bank
statement to balance your checkbook, and it is
not at all uncommon to find math errors in your
checkbook. So, you must then recalculate the
numbers in your checkbook register and jot
down the new answers. If you set up an Excel
workbook for the same tasks, you can use
formulas that subtract checks and add deposits.
You enter the formulas only once and simply
supply the amounts of your checks and deposits,
much as you record them in your checkbook
register. When you change the numbers in the

workbook, Excel uses the formulas to recalculate
the information in your workbook and instantly
gives you the new answers — in most cases
without the associated math errors.

Organize, Sort, and Filter Lists
You can create tables to organize your data in
lists. For example, you can create inventory lists,
employee lists, customer lists, student grade lists,
and sales records. In Excel, you can add, delete,
sort, search, and display records in the list as
often as required to maintain the list. You can
sort data on the worksheet alphabetically and
numerically in ascending or descending order.
For example, you can sort sales records in
chronological order by dates. You can also use
the AutoFilter feature to quickly find information
that meets a specific criterion or to find the top
or bottom ten values in the list without sorting. 

M icrosoft Excel is one of the world’s most
popular spreadsheet programs. You could
create worksheets on ledger paper and use

a calculator, or draw charts on graph paper, but Excel
makes these tasks and others related to managing

numeric information easier. You can use the program
to create worksheets, databases, and charts. Without a
doubt, you could perform the following functions
manually, but you can use Excel to make them easier.

05_181706 ch01.qxp  1/31/08  9:44 PM  Page 4

CO
PYRIG

HTED
 M

ATERIA
L



P
A

R
T

I
Getting Started with Excel

5

View Data
When working with a large worksheet on
ledger paper, such as a financial statement, you
might have to use a ruler to compare figures on
a far portion of the worksheet. You might even
find yourself folding the ledger paper to bring
the columns you want to compare close
together. In Excel, you can split the worksheet
into two or four panes to view distant figures
side by side. That way, you can easily see the
effects of asking “what happens when I change
this value?” to project changes. You can also
temporarily hide intermediary columns so that
distant figures appear right next to each other
as you work.

Make Editing Changes
To correct a mistake on ledger paper, you have
to use an eraser, or you have to reconstruct the
entire worksheet. With Excel, you can overwrite
data in any cell in your worksheet. You can also
delete data quickly, in one cell or a group of
cells. And, when you accidentally make
mistakes that overwrite original data while
using Excel, you do not have to retype or
reconstruct information. Instead, you can just
restore the data using the Undo button. 

Check Spelling
No more manually proofreading your work.
When you use Excel’s AutoCorrect feature,
Excel corrects commonly made mistakes as you
type — and you can add your own personal set
of “common typos” to the list. In addition,
before you print, you can run a spell check to
search for misspellings. If you are a poor typist,
this feature enables you to concentrate on
calculating your numbers while Excel catches
spelling errors. 

Make Formatting Changes
Excel easily enables you to align data in cells;
center column headings across columns; adjust
column width; and display numbers with dollar

signs, commas, and decimal points. You can
experiment with the settings until the
worksheet appears the way that you want it;
then you can print it. You can boldface,
italicize, and underline data, and change fonts
and font sizes. Excel also lets you shade cells,
add borders, and apply styles to improve the
appearance of a worksheet. 

Preview Before Printing
You can preview your worksheet to see how it
will look when you print it. You also can add
headers and footers and adjust page breaks
before you print. 

Chart Numeric Data
Numbers form the foundation of charts.
Manually creating charts is time-consuming and
takes some artistic skill. In Excel, creating charts
is quick and easy. You can track the sales trends
of several products with a chart. You also can
make as many “what if?” projections as you
want in the worksheet by increasing and
decreasing the numbers used in the chart; as
you change the numbers in the worksheet,
Excel instantly updates the chart. Excel’s charts
let you simultaneously view the sales trends in a
picture representation on-screen and the
numbers in the worksheet, making your sales
forecasting more efficient.

Getting Started with Excel chapter 1
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Start and Close Excel

Start and 
Close Excel
Y ou can start the Excel program using the

Windows Start menu. When you open the
Start menu, a search field appears at the

bottom and the All Programs choice appears
immediately above the search field. Once you select
All Programs, Windows displays folders that contain
the programs installed on your computer. The shortcut
to start Excel appears in the Microsoft Office folder.
After you select Excel from the Microsoft Office folder
several times, it will appear on the Start menu in the
list of recently opened files. You can select Microsoft

Office Excel 2007 from that list to open the program.
If you use Excel regularly, you may want to pin Excel
to the Start menu or create a desktop shortcut for it so
that you can open it more quickly.

You can close Excel using a command on the Office
menu, or you can use the Close button in the upper-
right corner of the Excel window. Excel behaves
differently, depending on the method you choose to
close the program, the number of workbooks you
have open, and whether you have made changes to
any of the open workbooks.

•

4

1

3

2

•

Start Excel

1 Click Start.

The Start menu appears.

2 Click All Programs.

• All Programs changes to Back.

3 Click Microsoft Office.

• The list of installed Microsoft Office
programs appears.

4 Click Microsoft Office Excel 2007.

6
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Does Excel prompt me to
save before closing the
program?

If you have not made any
changes to the workbook,
Excel closes without
prompting you to take
any further action.
However, if you have
made changes to an open
workbook, Excel prompts
you to save the workbook.
After you respond to the
prompt, Excel closes,
regardless of whether you
save the workbook.

Can I click the X in the
upper-right corner to close
Excel?

Yes, but, if you have more
than one workbook open,
Excel closes only the active
workbook, instead of the
program. You must click
the X in the upper-right
corner of each open
workbook. When you click
the X while viewing the
last open workbook, both
the workbook and the
program close. Before
Excel closes any workbook
you have changed, Excel
prompts you to save the
workbook.

What happens if I pin
Excel to the Start menu?

Excel always appears on
the left side of the Start
menu, above the list of
recently opened files.
Right-click the Excel icon
and click Pin to Start
Menu. 

How do I create a desktop
shortcut.

To create a desktop
shortcut for Excel, right-
click the Excel icon, click
Send To, and then click
Desktop (Create Shortcut).

The main window for Excel appears.

The cell pointer ( ) appears as you
move the mouse over cells in the
worksheet. You use the cell pointer to
select cells.

Note: See Chapter 4 for details on 
selecting cells.

Close Excel

1 Click the Microsoft Office button ( ).

2 Click Exit Excel.

Excel closes all open workbooks.
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Understanding the Excel Screen
E ach time you open Excel, you see a new

workbook named Book1 that contains three
worksheets.

B

F

H

IG

C A

D

I

E

A Title Bar
Displays the name of
the workbook and the
name of the program.

B Office Button
Opens a menu
containing commands
related to file
operations such as Save
and Print.

C Quick Access Toolbar
By default, contains buttons
that enable you to save, undo
your last action, and redo your
last action. You can also add
buttons to this toolbar; see
Chapter 30 for details.

D Ribbon
Contains most Excel
commands, organized
on tabs. See the
section,
“Understanding the
Ribbon,” for details.

E Formula Bar
Made up of three
parts, the Formula Bar
contains the Name
box, buttons that
pertain to entering
data, and the contents
of the currently
selected cell.

F Worksheet Area
The place where you
enter information into
Excel, divided into rows
and columns.

G Worksheet Tabs
Tabs that identify the
worksheet on which you
are currently working. You
can switch worksheets by
clicking a worksheet tab.

H Status Bar
Displays Excel’s current mode, such as Ready
or Edit, and identifies any special keys you
press, such as CAPS LOCK. The Status Bar also
contains View buttons that you can use to
switch views, and a Zoom control to help you
zoom in or zoom out. See Chapter 8 for more
information on views and zooming.

I Scroll Bars
Enable you to view more
rows and columns of the
worksheet.
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Learn Excel Terminology

Workbook
A workbook is a file in which you store your
data. Think of a workbook as a three-ring
binder. Each workbook contains at least one
worksheet, and a new workbook contains three
worksheets, named Sheet1, Sheet2, and
Sheet3. People use worksheets to organize,
manage, and consolidate data. You can have as
many worksheets in a workbook as the memory
on your computer permits. 

Worksheet
A worksheet is a grid of columns and rows. Each
Excel workbook contains 1,048,576 rows and
16,384 columns. Each column is labeled using a
letter of the alphabet; the column following
column Z is column AA, followed by AB, and so
on. The last column in any worksheet is column
XFD. Each row is labeled using a number, starting
with row 1 and ending with row 1,048,576. 

Cell
A cell is the intersection of a row and a column.
Each cell in a worksheet has a unique name
called a cell address. A cell address is the
designation formed by combining the column
and row names in column/row order. For
example, the cell at the intersection of column
A and row 8 is called cell A8, and A8 is its cell
address. 

Cell Pointer
The cell pointer appears as you move the

mouse over cells in the worksheet. You use the
cell pointer to select cells in the worksheet. 

Currently Selected Cell
You click a cell to select it. Excel identifies the
currently selected cell, also called the active cell,
by surrounding it with a bold, black box
containing a small, black square in the 

lower-right corner. That small, black square is
called the Fill handle; you can read more about
the Fill handle in Chapter 10.

Range
The term range refers to a group of cells. A
range can be any rectangular set of cells. To
identify a range, you use a combination of two
cell addresses: the address of the cell in the
upper-left corner of the range, and the address
of the cell in the lower-right corner of the
range. A colon (:) separates the two cell
addresses. For example, the range A2:C4
includes the cells A2, A3, A4, B2, B3, B4, C2,
C3, and C4.

Formula Bar
The Formula Bar is made up of three parts. At the
left edge of the Formula Bar, the Name box
displays the location of the currently selected cell. 

The Cell Contents area appears on the right
side of the Formula Bar and displays the
information stored in the currently selected cell.
If a cell contains a formula, the formula appears
in the Cell Contents area, while the formula’s
result appears in the active cell. If the active cell
contains a very long entry, you can use at the
right edge of the Cell Contents area to expand
the size of the Cell Contents area vertically. 

Between the Name box and the Cell Contents
area, buttons appear that help you enter
information. Before you start typing in a cell,
only the Function Wizard button ( ) appears,
as described in Part III; you can use this button
to help you enter Excel functions. Once you
start typing, two more buttons appear; click 
to accept the entry as it appears in the Cell
Contents area, or click to reject any typing
and return the cell’s contents to the way they
appeared before you began typing. 

W hen you learn anything new, you need to learn its
terminology. Presented below are a series of terms
you need to know as you work with Excel.
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Understanding the Ribbon

Tabs on the Ribbon
Tab Purpose

Home This tab helps you format and edit a worksheet.

Insert This tab helps you add elements such as tables, charts, PivotTables, hyperlinks, headers, and footers.

Page Layout This tab helps you set up a worksheet for printing, by setting elements such as margins, page size and
orientation, and page breaks.

Formulas This tab helps you add formulas and functions to a worksheet. 

Data This tab helps you import and query data, outline a worksheet, sort and filter information, validate and
consolidate data, and perform What-If analysis.

Review This tab helps you proof a worksheet for spelling errors, and also contains other proofing tools. From this
tab, you can add comments to a worksheet, protect and share a workbook, and track changes that others
make to the workbook.

View This tab helps you view your worksheet in a variety of ways. You can show or hide worksheet elements
such as gridlines, column letters, and row numbers. You can also zoom in or out.

T o accomplish tasks in Excel, you use
commands that appear on the Ribbon. New
to Excel 2007, the Ribbon fundamentally

changes the way you work in Excel compared to earlier
versions of Excel. You no longer open menus to find
commands; buttons for commands appear on the
Ribbon. By default, the Ribbon contains the commands
most commonly used to complete an Excel task. Do
not worry if you do not find a particular command on
the Ribbon; it is still available and, if you use it often,
you can add it to the Quick Access Toolbar, which

appears at the top of the Ribbon. See Chapter 30 for
details on customizing the Quick Access Toolbar.

On the Ribbon, in addition to the Office Button ( )
and the Quick Access Toolbar, you find tabs, which
take the place of menus in Excel 2007. Each tab
contains a collection of buttons that you use to
perform a particular action. On each tab, commands
are grouped together. For example, on the Home tab,
you find seven groups: Clipboard, Font, Alignment,
Number, Styles, Cells, and Editing. In the lower-left
corner of some groups, you see a dialog box launcher
icon ( ) that you can click to see additional options
that you can set for the group.

By default, the Ribbon contains seven tabs, as
described in the following table.

In addition to these seven tabs, Excel displays
contextual tabs, which are tabs that appear because
you are performing a particular task. For example,
when you select a chart in a workbook, Excel adds
the Chart Tools tab behind the View tab. The Chart
Tools tab contains three tabs of its own: Design,
Layout, and Format. As soon as you select
something other than the chart in the workbook,
the Chart Tools tab and its three sub-tabs disappear.

To use the commands on the Ribbon, you simply
click a button. If you prefer to use a keyboard,
you can press the Alt key; Excel displays keyboard
characters that you can press to select , tools
on the Quick Access Toolbar, and tabs on the
Ribbon. If you press a key to display a tab on the
Ribbon, Excel then displays all the keyboard
characters you can press to select a particular
command on the Ribbon.
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Work with the Mini Toolbar and Context Menu

Work with the Mini Toolbar
and Context Menu
Y ou can use the Mini Toolbar and the

Context menu to help you quickly format
text without switching to the Home tab. The

Mini Toolbar and the Context menu contain a
combination of the most commonly used commands
available in the Clipboard, Font, Alignment, and
Number groups on the Home tab. 

The Mini Toolbar and the Context menu always
appear together when you work with shapes, text
boxes, WordArt, or cells containing text or numbers.

The Mini Toolbar does not appear when you work
with pictures, charts, Clip Art, or SmartArt.

The buttons that appear on the Mini Toolbar do not
change; you always see the same set of buttons.
However, the commands that appear on the Context
menu, also called a shortcut menu, change
depending on the cells or object with which you are
working. That is, Excel displays only those
commands on the Context menu that are relevant to
the cells or object you select; this is how the Context
menu got its name. 

1

2 •

1 Select a cell or range of cells.

Note: See Chapter 4 for details on selecting cells.
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2 Right-click the selection.

• The Mini Toolbar appears above the
Context menu.
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Enter Information

Enter 
Information
Y ou can quickly and easily type text and

numbers into your worksheet. Most people
use Excel primarily to accomplish math-

related tasks, and supplying text labels for the
numbers you enter provides meaning to those tasks.
Although you can type information into a worksheet
in any order, some people find it easier to type labels
first, because it helps them identify the correct place
for corresponding numbers. 

You enter text using your keyboard, and you can enter
numbers using either the number keys above the
letters on your keyboard or the number pad to the

right of the letters on your keyboard. To use the
numbers on the number pad, you can press the Num
Lock key.

By default, when you enter text into a cell, Excel left-
aligns it in the cell and assigns it a General format.
When you enter a number into a cell, Excel right-aligns
it in the cell and assigns it a General format. Excel also
recognizes some dates that you type; as a result, it
right-aligns them in cells and formats them as dates.
Information in a selected cell appears both in the cell
and in the Formula Bar. For more information on
formats, see Chapter 3.

1

3

•

•

•

2

Enter Text

1 Click a cell to select it.

Note: See Chapter 4 for details on selecting cells.

2 Type text.

• As you type, the information appears both
in the cell and in the Formula Bar.

3 Click .

• The cell pointer remains in the cell you
selected in Step 1, and the text you typed
appears left aligned.

4 Repeat Steps 1 to 3 to enter other text labels.

12
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Can I edit or delete the information that
I type in a cell?

Yes. You can edit the information either as
you type it or after you type it by pressing
the F2 key on your keyboard to switch to
Edit mode. To edit as you type, just press
F2. To edit after you type, click the cell to
select it and then press F2. To change an
entry completely, enter new information as
described in this section. To delete all of
the information in a cell, select the cell and
press Delete. To delete both information
and cell formatting, see Chapter 3.

Why does my label in cell A1 appear
truncated while my label in cell B1 seems
to occupy both cells B1 and C1?

The information in both cells exceeds their
column widths. When an empty cell such
as C1 appears beside a cell containing an
over-large entry such as B1, information
seems to occupy both cells. However, Excel
actually stores all of the information in cell
B1; look at the Formula Bar as you select
cell B1 and then cell C1. The information
in B1 is also hiding part of the over-large
entry in A1. To view all of an over-large
entry on the worksheet, widen the column.
See Chapter 6 for details.

Enter Numbers

1 Select a cell and type a number.

2 Press Enter.

• The number you typed appears
right aligned in the cell you
selected in Step 1.

• The cell pointer moves down one
row.

3 Repeat Steps 1 and 2 to enter other
numbers.

Enter Dates

1 Select a cell.

2 Type a date in mm-dd-yy format,
separating the parts of the date with
either dashes (-) or slashes (/).

3 Press Enter.

• The date you typed appears right
aligned in the cell you selected in
Step 1.

• The cell pointer moves down one
row.

4 Repeat Steps 1 to 3 to enter other
numbers.
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Undo and Redo

Undo 
and Redo
Y ou can use the Undo feature in Excel to

recover from editing mistakes that might
otherwise force you to re-enter data. The

Undo feature in Excel is cumulative, meaning that
Excel keeps track of all of the actions you take until
you close the program. When you use the Undo
feature, Excel begins by reversing the effects of the last
action you took. If you undo four times, Excel reverses
the effects of the last four actions you took in the
order you took them. For example, suppose that you

edit a text label and remove some characters. If you
undo the action, Excel reinserts those characters.

The Redo feature works like the Undo feature, but in
reverse. After you undo an action, you can redo it. If
you undo several actions in a row, you can redo all of
them, in the order you undid them. For example, if
you undo typing and then the effects of resizing a
column, when you use the Redo feature, Excel first
restores the effects of resizing the column. If you then
immediately use the Redo feature again, Excel restores
the typing.

1

2

3

1 Perform an action.

In this example, text is typed.

2 Perform another action.

In this example, italics are added.

Note: See Chapter 3 for details on adding italics.

3 Click the Undo button ( ).

14
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Can I undo more than one
action at a time?

Yes. Click beside to
display the list of actions
you can undo. Click the
oldest action you want to
undo, and Excel undoes
all of the actions from the
oldest one you select to
the latest, showing you
the worksheet at the point
in time before you took
any of those actions. 

Can I redo more than one
action at a time.

Yes. The Redo feature
works the same way as the
Undo feature. To be able
to redo more than one
action at a time, you must
undo multiple actions
before you redo. Then,
click beside to
display a list of actions you
can redo. Click the oldest
action, and Excel redoes
all of the actions from the
oldest to the latest.

Why is the Redo button
unavailable when the
Undo button is available?

Excel keeps track of all
actions you take in all
open workbooks and
makes those actions
available to undo until you
close Excel. The button
will not be available unless
there are actions to redo,
and actions to redo do
not become available until
you undo an action. If you
then click to redo the
action you undid, then 
becomes unavailable
because there are no more
actions to redo.

• Excel reverses the last action. 

In this example, Excel removes italics.

If you click Undo again in this
example, Excel removes the text.

4 Click the Redo button ( ).

• Excel reverses the effect of undoing
by adding back your last action. In
this example, Excel reapplies italics.
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Move Around in a Worksheet

Move Around 
in a Worksheet
Y ou can use arrow keys to move around a

worksheet, moving the cell pointer up, down,
left, or right one cell at a time. If you hold

down an arrow key, Excel moves the cell pointer
repeatedly in the direction designated by the arrow
key. You can also move one screen at a time using the
Page Up and Page Down keys.

To quickly move to the first or last cell in a range, you
can take advantage of the End key. You use the End

key in combination with the arrow keys to move the
cell pointer to the top or bottom cell in a column, or
the left or right cell in a row. When you use the End
key, Excel displays “End Mode” on the Status Bar to
alert you that the cell pointer will move to the first or
last cell in the direction of the arrow key you use.

When you know the address of the cell in which you
want to work, you can move directly to that cell using
the Go To dialog box. 

•

•

•

1 Click a cell.

• Excel displays the cell pointer in that cell.

2 Press the right-arrow key on the keyboard.

• Excel moves the cell pointer one column to
the right.

You can press any arrow key to move the cell
pointer one cell in that direction.

You can press and hold an arrow key to
repeatedly move the cell pointer in that
direction.

3 Press the End key.

• The Status Bar displays “End Mode.”

16
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What happens if I click the
Special button in the Go
To dialog box?

Excel displays the Go To
Special dialog box, where
you can set special
conditions for Excel to use
to go to a particular cell.
For example, if you select
the Comments option,
Excel selects all cells that
contain comments. If you
select the Formulas
option, Excel selects all
cells that contain
formulas.

Where does Excel place
the cell pointer when I
move a screen at a time?

The cell pointer remains in
the same relative position
on the screen when you
press the Page Up or Page
Down keys. For example,
if D10 is the active cell
while viewing rows 1 to
27 and you press the Page
Down key, then Excel
displays D37 as the active
cell. However, the cell
pointer does not move if
you click in the horizontal
scroll bar.

What happens when I
press the Page Down key?

Excel displays the next
page of rows. For example,
if you are viewing rows 1
to 27 on one screen and
you press the Page Down
key, then Excel displays
rows 28 to 54. 

Is there an easy way to
move one screen to the
right or left?

Yes. You can click a blank
area in the horizontal
scroll bar that runs across
the bottom of the screen. 

4 Press the up-arrow key.

• Excel moves the cell pointer to the
first cell in the column containing
information.

You can use the End key with any
arrow key to move to the first or last
cell in the row or column containing
information.

You can press Ctrl+Home to move to
cell A1.

5 Press F5.

The Go To dialog box appears.

6 Type a cell address.

7 Click OK.

Excel moves the cell pointer to the
address you typed.

P
A

R
T

I
Getting Started with Excel

17

chapter 1

•

7

6

05_181706 ch01.qxp  1/31/08  9:44 PM  Page 17



Move Around in a Workbook

Move Around 
in a Workbook
Y ou can move between the worksheets in a

workbook using the tabs and controls at the
bottom of the Excel screen. By default, a

workbook contains at least three worksheets and you
can switch between them. If your workbook contains
more than three worksheets, it is possible that the tabs
for all worksheets will not be visible at all times. You
can use the controls to the left of the worksheet tabs
to scroll through hidden worksheets. The first and last
controls scroll all of the worksheet tabs to display the
first and last worksheets, respectively. The middle
controls scroll to display the next worksheet tab in the
direction of the control’s arrow. 

•

•

2

•

1 Open a workbook.

• Excel displays the first worksheet in the
workbook or the last sheet you viewed
before saving the workbook.

2 Click a worksheet tab.

• Excel displays that worksheet.

• To display additional worksheet tabs, you
can click these controls.

18

How can I make more worksheet tabs
visible at all times?

Resize the horizontal scroll bar by moving
the mouse pointer over the left edge of
the horizontal scroll bar. When the resizing
mouse pointer ( ) appears, click and
drag to the right. Excel makes more space
available for worksheet tabs and less for
the horizontal scroll bar.
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Manage the Status Bar

Manage the 
Status Bar
Y ou can add elements to, or remove elements

from, the Status Bar to display many
different types of information. When you

open a blank workbook, the Status Bar displays the
cell mode, the macro recording state, the View
shortcuts, the zoom factor, and the zoom slider. The
Status Bar is actually set to display a wide variety of
information, if conditions are right to display the
information. For example, if you press the Scroll Lock
key on the keyboard, Excel displays the state of the
Scroll Lock key on the Status Bar. 

The cell mode that appears by default in all
workbooks switches between four states. Ready mode
is a general state, and the state that appears when
no other state is appropriate. Enter mode appears as
soon as you start typing in a cell, and Excel returns
to Ready mode after you press Enter to store the
information in the cell. When you edit any cell entry,
Edit mode appears on the Status Bar. Point mode
appears on the Status Bar when you point to cells
that you want to include while setting up a formula.

•

•

•

1

2

3

1 Right-click the Status Bar.

• Excel displays the Customize Status Bar
menu. Each item with a check mark ( )
beside it will appear on the Status Bar
under appropriate conditions.

2 Click an item that does not contain .
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• Excel can now include that item on the
Status Bar.

• If appropriate conditions exist, the item
appears immediately on the Status Bar.

3 Click anywhere on the worksheet to hide the
Status Bar menu.
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